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Part V: Information Management

Most information at that stage was stored in separate files. A file might
contain information used to produce a particular report. Business had
hundreds of these files and developed computerized systems to manage
them. A file might contain information on employees, customers,
accounts payable, accounts receivable, inventory, payroll, work in
progress, shipping, receiving, or any other type of information used to
produce a management report or account for a transaction. Programs,
or groups of programs, were written to manage each of these files, and
information management systems based on this method of data
processing were known as file management systems.

The process of keeping files up-to-date, complete, and correct is known
as file maintenance. Many problems are associated with maintaining
multiple, separate files. For example, much of the information in one
group of files may be repeated in other files. This repetition is known as
redundancy. Systems that had to maintain hundreds of separate files ran
into the same problems encountered by an individual maintaining a
3x5 card file. When information changed, all the files containing that
information had to be individually updated, a process that was time-
consuming, expensive, and prone to error. Unfortunately, the problems
associated with updating redundant data can result in an item of
information existing as different versions in the same system.

These types of information management systems did automate the
transactional and operational aspects of a company’s information
resources, but they did little to help higher management. Each
department or division maintained its own records, and company-wide
management systems were not available. Management wanted a way to
tie these systems together into a management information system (MIS).

At the time, however, several problems prevented this from happening.
First, the information on the computers was stored on reel-to-reel
magnetic tape. A large file might be stored on several tapes, and finding
a particular item of data to change might not be accomplished easily and
quickly. Second, the information was redundant, so it might take
mounting and modifying several tapes to accomplish a change. Third,
the information was stored in locations that might be widely separated,
and data communication over phone lines was slower, more expensive,
and less reliable than it is today.

Hardware, software, and procedures changed in the 1970s. The first
problem, data storage, was solved when the price of disk drives declined
dramatically. Not only did the price decline, but also the reliability of
disks and the amount of data that could be stored on a disk increased.
In a few years, most computer systems were using disk drives as their
main method of data storage.

Tapes store information sequentially; that is, one item after another. To
reach an item, all the preceding tape must pass through the system, like
finding a particular song on an audiocassette. This method is known as
sequential access. Disk drives can access information sequentially, but
they can alsolocate information directly, a process known as direct access
(or random access).
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Databases

The ability to access information directly led to the solution of the
second problem, redundant information. Methods were devised to
organize information so it could be accessed and processed more
efficiently. The organizational method chosen for storing information
in related files was the database. Three major types of databases are
currently in use: hierarchical, network, and relational. Of these, the
relational model is used popularly in microcomputer database systems.
Therefore, it is the only one that will be explored here.

Relational Databases

A relational database can be composed of one or more related files. Each
of these files is organized into a tabular structure consisting of rows that
represent records (also known as tuples) and columns that represent
fields (also known as attributes or items).

One of the major advantages of a relational database over a file
management system is the reduction of dataredundancy. As an example,
schools must manage a lot of information about courses offered,
instructors, students, which courses students have taken, when courses
were taken, and grades received in the courses.

In a file management system, you might include a student’s name,
address, phone number, and other pertinent information every time
she or he takes a course; if the student takes 40 courses, the system would
contain 40 occurrences of all this information. What do you do when
the student’s address changes? You have to find and change all 40
occurrences and make sure they all match.

Using a relational database system, information can be divided into
multiple files, each of which is designed for efficient data storage. For
example, you can store all the basic student information in the student
file, which would consist of name, address, phone number, financial aid
status, scholarship status, any disciplinary action taken, and other
pertinent information. The student is assigned a unique identifying
number (usually his or her Social Security Number), and this number
is used to relate information in one file with information in another
file. A field used to relate information in more than one file is known as
a key field.

An example of a partial student file is shown in Figure 10-2.

Student Number Last Name First Name  Phone

111-22-3333 Godfrey Geneva 555-6848
123-45-6789 Adams Rebecca 555-7452
321-54-9876 Prather Lillie 555-1597
666-88-7777 Avary Arch 555-7486
987-45-1236 Borreson Lori 555-3287
999.99-1111 Cavalier Jamie 555-5874

Figure 10-2 Example of a student file
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One way to look at the contents of this file is to think of it as a table of
information. There are multiple rows and columns (like a spreadsheet)
in the file. All the information on a particular student will be located
on the same row. Each row represents one record in the file (see
Figure 10-3).

Student Number Last Name  First Name Phone

111-22-3333 Godfrey Geneva 555-6848
123-45-6789 Adams Rebecca 555-7452
321-54-9876 Prather Lillie 555-1597
666-88-7777 _ Avary Arch - 555-7486
987-45-1236 Borreson Lori 555-3287
999-.99-1111 Cavalier Jamie 555-5874

Figure 10-3 A student record in the student file

Each column in the table represents a single field. Figure 10-4 shows the
field that represents the students’ last names.

Student Number Last Name  First Name Phone

111-22-3333 Godfrey Geneva 555-6848
123-45-6789 Adams Rebecca 555-7452
321-54-9876 Prather Lillie 555-1597
666-88-7777 Avary Arch 555-7486
987-45-1236 Borreson Lori 555-3287
999.99-1111 Cavalier Jamie 555-5874

Figure 10-4 The Last Name field in the student file

Class names and the instructors assigned to teach the class could be
stored in a class file. Of course, like the student file, more information
would have to be in this file than what is shown. Each class is assigned
aclass number, usually consisting of an abbreviation for the department
teaching the course followed by a unique identifying number for the
course within that department. Other information such as credit hours,
class hours, lab hours, and prerequisites would probably be in the file as
well. Figure 10-5 shows a partial example of a class file.

Class Number  Class Name Instructor
ACC 103 Cost Accounting Nichols
ART 101 Art Appreciation Dockery
BUS 211 Office Machines Hughes
EDP 150 Pascal 1 Dillard
EDP 641 Compiler Design Young
PHY 453 Thermodynamics I Erker

Figure 10-5 A class file
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A record of all courses taken by all students could be maintained in a
completed courses file (see Figure 10-6). This file would contain two key
fields. The Student Number field is used to relate to information in the
student file, and the Class Number field relates to information in the
class file.

Student Number Class Number Qtr Taken Grade
111-22-3333 ACC 103 92-3 A
123-45-6789 EDP 150 91-4 B
321-54-9876 BUS 211 91-2 A
666-88-7777 ART 101 92-4 B
987-45-1236 PHY 453 90-1 B
999-99-1111 EDP 641 91-3 A

Figure 10-6 The completed courses file

When a student requests a transcript, the registrar enters the student
number assigned to that student (or former student). The database
program sorts the completed classes file by the Qtr Taken field (if the file
is not already stored in that order), finds every occurrence of the student
number in the file, and then prints a transcript. Of course, additional
processing is necessary to group the courses by quarter (or semester),
calculate the quality points earned (based on credit hours and grade
received), and calculate the student’s grade point average for each
period and the cumulative grade point average. Additional information
may be added to the transcript based on information stored in other files
for honors earned and extracurricular activities that may be noted.

A database system using multiple, specialized files reduces redundancy
to the point where data is duplicated in the key fields only. Specifying
that the information in the key fields must not be modified eliminates
the problem of updating multiple occurrences of an item. If a student
moves, any information that needs to be changed can be found in one
place.

Each file is simple in design and easy to update. Associating, or relating,
information in different files leads to less wasted space on the disk and
areduced possibility of information being partially updated. Unforeseen
information can be added to reports by creating and relating new files,
modifying the program to look up information in the new files, and
adding this information to the report as needed.

Network Databases

The third problem that had to be overcome before management
information systems became widely useful was communication between
distant systems. In the 1970s data communication became cheaper,
faster, and much more reliable. This led to formation of wide area
networks. A wide area network is formed when several computer systems
communicate with each other by sending information over a common
carrier, such as the phone system.
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Digital signals used in computers are not compatible with the analog
signals used in phone systems. Therefore, to send and receive computer
information over the phone lines, a conversion device is used. This
device, known as a modem, modulates a computer’s digital signals into
sound (analog signals) at one end of the phone system, and a compatible
modem demodulates the sound back into electronic digital signals at
the other end for the other computer. The term “modem” derives from
the process of modulating and demodulating.

Today, hundreds of databases are available worldwide on computer
networks. Anyone with an account and a password can use these
systems to access many types of information and to send and receive
messages (a process known as electronic mail).

With computers communicating over the phone lines, information
could be accessed directly, and transactions could be processed as they
were made instead of being entered into the system at a later time. This
was known as transaction processing. The 1970s brought a big increase
in transactional processing systems.

In the 1980s information management systems became widely available.
With the introduction and widespread availability of microcomputers,
information management systems went through similar stages of
evolution as were seen in mainframes and minicomputers in the 1960s
and 1970s. First, file management systems became available, and these
were quickly followed by more powerful database systems.

Recently, information management systems, which were formerly
described using traditional terms (“file management systems” and
“database systems”), have begun to blur the distinctions between the
two traditional system types. In the world of microcomputers, most
people refer to any information management system as a database
system, regardless of whether it meets the technical definition. Bowing
to popular usage, this book will refer to programs such as FileMaker
as databases.

Microcomputers brought another difference to computing. It is very
likely that a company will have many microcomputers located in the
same building. This situation is not as likely with minicomputers and
mainframes. As communications became more important during the
1980s, a new method of connecting computers was developed and
became known as a local area network. A local area network (LAN),
technically, is a connection of communicating computers that do not
use any lines or equipment belonging to a common carrier. By popular
usage, a group of microcomputers that send and receive information to
and from each other is called a LAN.

Just as minicomputers and mainframes developed database systems
that operate over a wide area network, microcomputers now have
databases that work over a local area network. This allows multiple users
to modify information on a common database from any computer
having access to the LAN. Once again, departments in large companies
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have their own local database management facilities. But, for the first
time, small companies have access to computing power similar to that
relegated to only the world’s largest companies a few years ago.

USES OF INFORMATION MANAGEMENT SYSTEMS

Some of the activities and terminology associated with managing
information have already been presented, along with some of the
pitfalls of manual methods. Computerized information management
systems are designed to automate many tasks. Specifically, these programs
will help you do the following:

e Organize your information

= Store that information

e Perform mathematical calculations
e Add new records

* Delete existing records

e Edit the contents of selected records

* Retrieve individual records or groups of records that match specific
criteria

e Sort the information into a different order

e Print reports in different formats

Each of these functions is discussed below.

Organizing Information

Storing Information

Several types of information management programs exist, but all of
them are designed primarily to lielp you organize information, store it
on the computer, retrieve information, modify it, and produce reports.
Information can be organized into databases, files, records, and fields.

When you have determined the organization of the information, you
describe it to the computer by creating a new file. At this time, the
program requires you to specify each field to be used and what type of
information will be contained in that field (date, number, text, graphics,
formula, and so on). In most information management programs, only
one type of information may be contained in each field.

Once the organization is described to the computer, you may then add
information to the file. This is usually done by creating a new record and
then filling in each of the fields for that record. For a customer, this
might involve entering name, address, phone number, credit rating,
creditlimit, and other information that describes that particular customer.
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Performing Calculations

Adding Records

Deleting Records

Editing Records

Not all information is directly typed into a file. Whenever calculations
are required, it is frequently easier (and more accurate) to let the
computer do them for you.

For example, if you were a real estate agent and wanted to add a new
house listing to your file, you could have fields set up for, among other
things, the length and width of the house. Then when you enter this
information, the program could multiply the contents of these two
fields and store the square footage of the house in the appropriate field.
You could even have the cost per square foot calculated automatically.

When you first defined the contents of the file, you might have entered
theinformation you had availableat that time. Information management
programs also allow you to enter new information at any time after the
file is created.

If you are running a business, you (hopetully) will have a steady stream
of new customers discovering your store and purchasing the items you
sell. Therefore, the information management program must allow you
to add new customers.

Not only does new information present itself and old information
change, but also eventually some information becomes obsolete. Suppose
you have a list of insured household items, and one of the items listed
isatop-quality 35mm camera. The camera was very expensive when you
bought it, but even with proper care and attention it finally wore out.
When you discard the camera, it is also appropriate to discard the
information in the insured items file.

The information in each record will be as correct as it was when you
entered it, but, as we all know, things change.

Suppose you maintain a list of the names and addresses of your friends.
Over a period of several years, chances are that many of them will have
different addresses from the ones you entered originally.

Information management programs allow you to retrieve the record
containing the information on a particular friend, and then you can edit
any information stored in that record. For example, if a friend has
moved to a different state, the street address, city, state, Zip code, and
telephone number will have to be changed.
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Retrieving Records

Sorting Records

Thereis anotherreason that the ability to modify information contained
in a file is important. When the information was originally entered,
there is always the possibility that it was typed incorrectly. The program
has to allow you to correct mistakes easily.

Information that has been entered into the computer is of little value if
you can’t retrieve it at a later time. If you have a list of customers and
want to send a special mailing to all who live in a particular city or town,
you can have the computer search through the list and select only those
whose city matches the one in which you are interested. In this way you
can select subsets of the entire customer file. In this case, the subset is
the group of customers who live in a particular city.

You can also find a single record. Suppose you have a file that contains
information on improvements that you have made to your house. At a
later time, you want to find the total cost of adding the deck. If the
improvement was entered as “deck”, you can tell the program to find
the record containing “deck” and it would very quickly find the record
and show it to you on the screen.

You might also need to find information on a person, but you can only
remember part of that person’s name. In manual systems, you would be
forced to look through each card until you found what you were looking
for, but in a computerized system, you can tell the computer to find all
names that match the portion you remember. The computer will do this
many times faster than you can.

An information management system can quickly sort an entire file, or
subset of the file, to display information in any order you want.

The records in a file are sorted into order by the contents of a chosen
field, known as the sort field, or the field on which the sort order will be
based. Common sort field selections include the name fields for alphabetic
sorts, Zip code field for printing mailing labels, amount-sold-this-year
field to find the best customers, and so on.

Forinstance, if you have a name and address file, and you want to group
the people by city, you could sort first by city, then by last name, then
by first name, and the information would be sorted accordingly. If you
had the following list of names and cities:

Wesley Myers-Smith  New York

June Kelong Boston
Don Herring Atlanta
Dena Taylor Boston
Diane Herring Atlanta

Luke Kelong Boston
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Creating Reports

The city, last name, first name sort command would give the following
list:

Diane Herring Atlanta
Don Herring Atlanta
June Kelong Boston
Luke Kelong Boston
Dena Taylor Boston

Wesley Myers-Smith  New York

Note that the people living in a particular city are grouped, and the cities
are presented in alphabetical order. Then, within each city group, the
people are sorted alphabetically by last name. If more than one person
has the same last name, they are further sorted by first name.

Sorting does not change the placement of the fields in the report, it just
modifies the order in which each record is displayed or printed.

Historically, the main use for an information management system was
to organize information so that reports could be produced. The
information was entered into the computer, and the computer sorted
and selected the records that met the specified criteria. Then, the
information was output in the form of a printed report.

Since those early days, adifferent type of use has evolved. Minicomputers
and microcomputers led to an interactive form of information
management. Interactive use of an information management system
provides timely information on a specific subject almost immediately.

There still are times, however, when printed reports are more useful
than interactive access. For instance, your bank maintains all of the
transactions affecting your checking account in its database, but at the
end of the month it sends you a printed statement so you can verify both
your set of records and the bank’s. Any financial accounting system
must maintain a paper trail, or series of printed reports, for auditing
purposes.

In the next two chapters you will be introduced to two popular
information management systems for the Macintosh: FileMaker II and
HyperCard.

CHAPTER SUMMARY

e Each piece of information is called a field or item. Several related items that describe one
person, place, or thing are called a record. Multiple related records may be grouped together
into a file. A database is composed of several related files.
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* Data is raw information. When data has been organized (processed) so that it becomes
accessible and useful, it is known as information.

e Businesses manage four major resources: money, materials, people, and information.

e Information must be correct and up-to-date to be useful. There is a time value associated with
information, because old information is not as valuable as current information.

¢ Different people in a business organization have different information needs. Information
management systems provide both interactive access and printed reports. Common reports
include detail, summary, and exception reports. In some cases, particularly financial
accounting systems, printed reports are necessary to provide an audit trail.

¢ What if... analyses are used to answer questions about future possibilities. For users trying to
develop accurate projections, computers allow the examination of multiple scenarios such
as, “What if the inflation rate is 3 percent?” or “What if the inflation rate is 6 percent?”.

e Early information management systems were known as file management systems because
information was stored in separate files that were not associated with each other. Later,
database management systems were designed to allow the information in several files to be
associated (or related), to reduce redundancy, and to allow easier updating of information.

e Information in a database is stored on disk drives, so the information can be directly accessed
and updated. Many computer systems communicate with other computer systems over
networks. Microcomputers are often connected over a local area network to allow for sharing
of information between computers and to allow interactive access to a centralized database.

KEY TERMS

common carrier key field
data local area network (LAN)
database
detail report management information system (MIS)
direct access modem
electronic data processing (EDP) random access
exception report record
redundancy
field relational database
file
file maintenance sequential access
file management system sort field
information

item
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Chapter 11: FileMaker Il

What You Will Learn in This Chapter

After reading this chapter and completing the projects in it, you
should be able to:

e Create a new file and enter data into it

* Modify data in a file

* Delete records

¢ Find specific records and records that match one or more criteria
¢ (Create a new layout

e Create calculation fields

¢ Create detailed reports

e Print reports

e Link files together using lookup fields

programs for the Macintosh. It will do all the standard tasks found

in a program that manages information on a personal computer.
Unlike similar programs on most other computer systems, however,
FileMaker is designed for use on the Macintosh, and it takes advantage
of the Mac’s graphics capabilities to help you create reports with visual
impact and style.

FileMaker is one of the best-selling information management

STARTING FILEMAKER

Filelaker |l

To start working with FileMaker, you need to have the FileMaker II
application and the Inventory data file loaded into your computer. The
Inventory file is included on the Macintosh Journey Projects disk that is
available for use with this book. (Project 1 in Chapter 1 tells you how to copy
all the files on the Projects disk onto your data disk.)

This Inventory file will be used later in Project 3. Let’s open it now and
take a look at it.

= Double-click on the Inventory data file icon, as shown in
Figure 11-1.
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&€ File Edit Uiew Special

S[j=———— steven Boltzmann Data ———=0

11 items 483K in disk 303K available

{ Greeting Card Art  Geno's Menu Unformatted Menu Artwork

Traveling Times Unformatted Traveling Times Logo

& &

Glossary Yisual Effects Class Notes Buttons

Inventory Final Projects

Figure 11-1 Opening Inventory file from the desktop

In a few seconds the Inventory file will open and you will see a screen
like the one shown in Figure 11-2 (without the arrows and labels).

" & File Edit Select Gadgels Formot Custom Window

[
= % F Part Number  Desoription Unit Cost
e 1001 WIPER BLADES B8.53
0 1002 WIPER MOTOR 36.95
1003 WINDOVW BRACKETS 8.79
DOOR HANDLE 2398
17.26
11.25
LOOR MATS 35.68
KEY LOCK 36.50
1009 RADIATOR HOSE 5.63
1010 RADIATOR CAP 8.95
1011 AIR FILTER 5.89
1012 ELIEL EILTFED 15
] Browse KA]
~s
1. Slide control handle 4. Status area
2. Book 5. Fields

3. Active record indicator

Figure 11-2 What's what on the FileMaker screen

The opening screen tells you a lot about the Inventory file. The status
area shows there are 20 records in the file, and the first record is active.
The active record can be determined in two ways: the center page of the
book has the number 1 displayed, and the active record indicator (the small
black area between the two vertical lines) is next to the first record.
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BROWSING THROUGH THE FILE

At this point you should see the first 12 records in the Inventory file on
your screen. This means that 8 more records are not currently visible.
You can see them by scrolling through the file.

There are two ways to scroll through the records. The first is to use the
slide control handle, and the second is to click on the bottom page of the
book.

The slide control handle method (see Figure 11-3) will let you smoothly
and quickly slide to a particular record if you know the record number.
As you pull up or down on the slide control handle, the current record
number is displayed on the middle page of the book. When you release
the handle, the display scrolls to the record indicated in the middle book
page. Thisis particularly efficient when you want to go to the first or last
record in the file.

Records: Records Records
20 20 20

Figure 11-3 Changing active record with slide control handle

Notice that the top page of the book is blank when the first record is
active, and the bottom page is blank when the last record is active. A
page with simulated text on it shows that there are additional records
in that direction.

The second scrolling method, clicking on the bottom page, will take you
one record closer to the bottom of the file (see Figure 11-4). You can also
click on the top page to move closer to the first record in the file.

Before

Records: Fecords:
20 20

Figure 11-4 Changing the active record by clicking on the book
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GETTING HELP

Whenever you are using a program such as FileMaker, there are times
when you haven’tlearned, or can’t remember, the proper procedures or
commands to perform. FileMaker Il includes online help so you won't
have to stop what you are doing and find the information in the
reference manual.

= Choose Help from the Apple menu (see Figure 11-5).

Ul File Edit Select

= About FileMaker... E

Help... 3/

Formet Custom Window

Gadgets

e,

Edit Description Unit Cost
Acta WIPER BLADES 853
Alarm Clock WIPER MOTOR 36.95
Calculator WINDDW BRACKETS 8.79
Calculator+ DOOR HANDLE 23.98
gh:?:;fp | MIRROR MOUNT 17.26

ol ane
dCAD Calculator ?:Eggkniigug ;;2:
DeskDraw™ 2
DeskPaint™ KEY LOCK 36.50
DeskPaint™ 2 RADIATOR HOSE 5.63
DeskPaint™ 3 RADIATOR CAP 8.95
Display Message AIR FILTER 5.89
Expressionist™ EUEL CILTED _ z4c
v

T O

T

Figure 11-5 Getting FileMaker help

This brings up the opening screen for the help facility, offers some
information on using FileMaker, and allows you to open the Help file
(see Figure 11-6).

'nnle Edit Select Gadgels Forme! Custom Window

the Select Menu.

O To type in a field, press Tab or click in a field.

[0 To turn to another record, click a page in the book.
Feg [J To add or delete records, choose from the Edit menu.

To view, edit, add, and delete records, first choose Browse from

To find a group of records, choose Find from the Select menu,
then type a request and click the Find button.

To reorder the records, choose Sort from the Select menu.

To change the appearance of records for display and for
printing, choose Layout from the Select menu.

To create new fields, choose Define from the Select menu,
' |(open Heip Fite]] [cancet)

]
Figure 11-6 Opening the Help file

= Click Open Help File.
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If the FileMaker Help file is not on your disk, you must quit FileMaker
and then copy the Help file from the distribution disk into the folder on
your hard disk that contains FileMaker. Then you can re-enter FileMaker
and again try opening the Help file,

If you originally installed the Help file properly, or if you just went back

and installed it, when you click the Open Help File button, you will see
the screen shown in Figure 11-7,

~

" & File Edit Select Gadgets Forma! Custom Window

= FileMaker Help [T

K

USING THE HELP FILE 1

To browse through the Help file:
Click the pages of the book on the left to see other topics.
General information is at the front of the file. More detailed information is towards
the back.

Records:
6%

To choose a topic:
Choose the topic you want from the Custorn menu. Then olick pages in the book to see
additional information,

To close the Help file and return to using FileMaker:
Choose s from the File menu. (Or, leave the Help file open while you work with
another file; choose the file you want from the ‘Window menu or uze the dosn
command to open the file.]

For more information, see the pages of the FileMaker manual referenced at the bottom
of the screen,

® To see other records on this topic, click pages of the book at the top left of the window.
® For more help on this topic, see the FileMaker Il Owner s Manual, pp. 82-83,
® For help on other topics, choose the topic you want from the Custorn menu.

ﬁﬁ Browse ¢|i
S

A2l

o

Figure 11-7 Using the Help file

= [f your screen does not look like the one shown in Figure 11-7,
choose Using the Help File from the Custom menu.

The status area shows that there are a total of 69 records in the Help file.

If youwant help on other topics, you can choose Scripts from the Custom
menu (see Figure 11-8). Or, to make it even easier, you can choose one
of the options available in the Custom menu.

& File Edit Select Gadgets i'erumtlUlndow
FileMaker Help

Scripts

Using the Help File
FileMaker Concepts

Peytorm

fAdding and Editing Records
Finding Records

Sorting Records

Arranging Information
Printing and Previewing
Exchanging Data Between Files
Automating Commands
Keyboard Shortcuts

(e )
Exit

WFor mare help on iz topic, see the Fileraker 11 Dwner s ['3NUAT, pp. 52-B5.
# For help on other topics, choose the topic you want from the Custorn men.

[[] erowse K3I
e

sl

T

Figure 11-8 Scripts dialog box
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\
Forinstance, if you want more inﬁormation onunderstanding FileMaker

concepts:

= Choose FileMaker Concepts from the Custom menu.

" & File Edit Select Gadgels Formaotl Custom Window
FileMaker Help

[

- WHAT IS A FILEMAKER FILE?

-1 A FileMaker file is a Macintosh document that stores your data. A file contains a

ﬁ sequence of records. Each record stores related information about a company,

transaction, person, or whatever topic you want. Within each record are fields. Each

Records: field contains a specific piece of information, such as a company name, a date of &

69 Y tranzaction, or a person’s salary.

Found:
5 In addition to providing a structure for storing your information, FileMaker provides the

flexibility to display and print your information in the form you need. FileMaker s
Layout capability gives you complete control oyer the appearance of your data.

Each file occupies its own window on the desktop, and you can have up to 16 files open
at once. All open files are listed in the Window menu. The file in the aotive window is
called the current file, and it is checked in the menu. To make a different file the
current file, you just choose it from the menu.

® To see other records on this topic, oliok p.gu:' of the book at the top left of the window.
® For more help on this topic, see the FileMaker || Owner’s Manual, pp. 7-16.
® For help on other topics, choose the topio you want from the Custorn menu,

| el

m Browse [ [o]

Figure 11-9 FileMaker Concepts help record

This shows the first of five records associated with this topic (look at the
status area below the book). Notice, at the end of the next to last line
on the screen, that you are told to see pages 7-16 in the FileMaker II
Owner’s Manual for further help. This field is updated for each record
in the help file, and it will tell you where to look for more information

on each of the 69 records.

If you can’t find what you need listed in the Custom menu, choose Find
in the Select menu and tell it what you want to find in the Help file.

= Choose Find from the Select menu.

This brings up the following screen (see Figure 11-10), where you can

enter your search criteria.

[

3

& File Edit Select Gadgels Format Custom Window
E[J&==—————— FileMaker Help =EI§|

= z

() .
® To see other records on this iwi!c.._ql!cs. pages of the book at the top left of the window.

® For more help on this topic, see] |
® For help on other topics, choose the topic you want from the Custom menu,

E find  KJ| |

it

Figure 11-10 Finding information in the Help file
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Now suppose that you want to find more information on how to add
automatic page numbers to a report.

= Clickin the field across the top of the FileMaker Help window, then
type Page Number as shown at the top of the screen (see Figure 11-
10), and then click the Find button.

This finds one record with the information on page numbers and tells
you to see pages 184-186 in the reference manual (see Figure 11-11).

" & File Edit Select Gadgets Formot Custom Window i

|§ =——— FileMakerlep =——————"|

1
h PRINTING THE TIME, DATE, PAGE NUMBER, OR RECORD MUMBER |

/ 1 You can tell FileMaker to print the time, today ‘s date, the page number, or each record
l number by typing special symbols in layout text on any layout:

Petords :: (two colons) to have FileMaker print the time (from the Macintosh Control Panel).

7 The time is displayed when you preview or print records.

Found :
1 £/ (two slashes) to have FileMaker print today ‘s date (from the Macintozh Control

Panel). You can use the Fvmaaf fade cornmand in the Format menu to change the

appearance of the date. The date iz displayed when you browse, preview, or print

records.

*2 (Yuro number signs) to have FileMaker print the page number. The page number is
displayed when you preview or print records. When you choose A¥¢ you can specify
the number to start with as well as the range of pages to print.

@@ (two "at” signs) in the body of the layout to have FileMaker print the record
number . The record number is displayed when you preview or print records.

® To see other records on this topic, click pages of the book at the top left of the window.
® For more help on this topic, see the FileMaker || Dwner’s Manual, pp. 184-186.
® For help on other topics, choose the topic you want from the Custom menu.

E Browse '(:\I fﬂ)

|

Figure 11-11 Page numbering help

Read this screen to learn about the codes used to add the current time,
date, page number, and record number to any layout.

Take a few minutes now to look through the Help file and familiarize
yourself with what is available and where you can find it.

When you are finished with the Help file, you can close the FileMaker
Help window and go back to using the Inventory file. Whenever you
close the Help file, you will be returned to whatever file was in use before
you asked for help.

w  Close the Help file by clicking in the close box.

This brief overview of the Help command should give you a start in
using this handy feature provided with FileMaker.
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SAVING YOUR WORK

Unlike other programs, information management applications such as
FileMaker have no Save command. Since the application is designed to
allow you to enter and update information, your work is saved
automatically by the program.

When you create a new file, you are given the opportunity to specify the
name of the file, the drive on which to store it, and the folder (if any)
in which it will be saved. Then, as you work with the file, FileMaker will
save it for you periodically.

This has some good features, as well as a couple of potential problems
of which you need to be aware. When everything works correctly, you
will not lose any information. That's good. However, when something
goes wrong, it may damage a FileMaker data file. There are two ways to
guard against serious problems with your data file: backing up the file
and saving a copy of the file.

You must remember to make a backup copy of any file that contains
important information when working in FileMaker.

The first reason for backing up is to make an insurance copy of the file
in case of computer, disk, or power failure. If your equipment fails you
can lose important information. Making backups is the only way to keep
from losing information.

The second reason is important whenever you use a program that
automatically saves your work for you, especially when every
modification to a file is not saved when you make the change. FileMaker
can tell when you are not working with the file. When you take a break
or stop to talk to someone or to read something and you are not actively
using FileMaker, it will take this time to save the file. It does not save
every modification immediately after the change is made.

There are times (between when FileMaker last saved your file and you
take the next short break) that the file on the disk does not match the
work you have done. You might have made some important changes to
the file since the last time it was saved. If the power goes out, there is the
potential that your file might be damaged.

Another action that can damage a file is to stop working while FileMaker
is running and just turn off the computer (before FileMaker has a chance
to save your last modifications to the file). Many computer users
develop this bad habit when working with other programs. For example,
you could open MacPaint, create a painting, save it, print it, and just
turn off the computer. Chances are you would not encounter any
problems by doing this.
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However, this is a very bad habit. When you are using a computer as
sophisticated as the Macintosh, you must follow proper procedures to protect
yourself from losing data. Always choose Quit to close an application, and
then choose Shut Down before turning off power to the computer.

When using FileMaker, it is imperative that you quit the program
properly. When you close afile, it is updated so that the copy on the disk
matches what is in the computer’s memory. When you choose Quit,
FileMaker will update any open files.

If you do not follow these procedures, you are leaving yourself open for
problems. The easiest way to avoid problems is to backup your work and
quit FileMaker properly.

FileMaker also allows you to save a copy of the file at any time while you
are working. (This is similar to the Save As command in other programs.)
Saving a copy of the file you are using is a good habit to develop. In this
chapter, you will be reminded to save a copy of a file when you have
made major modifications to it, but you will not be reminded to make
backup copies using the Finder.

Naming and deciding where to store a file will be covered when you
create a customer file in Project 1. You will be introduced to saving a
copy of a file after you enter data into that file.

This concludes the introduction to FileMaker. Before you continue with
Project 1, you should close the Inventory file.

w  Choose Close from the File menu.

Project 1: Creating a Database

Let’s suppose that you are the owner of B & K Auto Parts, a store that sells
to customers around the country. You publish a catalog and advertise
in a number of large cities. Some of your customers are individuals, and
others are businesses that use or resell the parts they purchase from you.
You want to use FileMaker to keep track of customers and inventory and
to automate the production of invoices when customers place orders.

In Project 1, you will create a Customers file. You will learn how to define
the fields for each customer, enter data, format the fields for proper
display, edit the data, and print the contents of the file.

In Project 2 you will learn to print detailed reports based on information
in the Customers file. In Project 3 you will create the Sales Invoices file,
and you will learn to interconnect files and create invoices using
information looked up in the Customers and Inventory files.

In these three projects, you will learn the basics of using FileMaker.
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New Record
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" & File Edit Select Gadgeis Format Custom Window

E[[===———=———— (ustomers =————[=

: PREFIX {lMs.
| FIRST :Sandra

] M1 M.
S Hardin

LAST
TITLE
COMPANY
ADDRESS (497 Seemore Drive, Apt. 3

ciTy (Asheville

STATE {NC
zip (29702
COUNTRY
AREA CODE {234

PHONE NUMBER 1555-2922

ENTRY DATE |7/11/86

PPN

s
g Browse ¢|| |[>|EJ

Figure 11-29  First record after entering data

When you are sure the information is correct, tell FileMaker to accept
this customer and create a new record for the next customer.

# Choose New Record from the Edit menu.

Ms. Hardin is now added to the file. FileMaker checks to see that there
is something entered into the last name field and that the customer
number is different from all other customer numbers in the file. It
performs these checks because you told it to do so when you specified
the entry options while defining the fields.

When record 2 is created, it becomes the active record, and the insertion
point is positioned automatically in the first field of the record, which
is the PREFIX field. Since the PREFIX field has a list, the list becomes
visible and the computer waits for you to select one of the entries (see
Figure 11-30). Remember, however, that you can type a prefix directly
in the field if what you need to enter is not in the list.

" & File Edit Select Gadgefs Format Custom Window
Customers

PREFIX
FIRST [Mr.

M1 [Ms.

LasT |Mrs.

Time (D6
comPaNy RV
ADDRESS
cITY

STATE

zIP
COUNTRY
AREA CODE
PHONE NUMBER
ENTRY DATE

==

Records:

el e

1a0a

L
E Erowse [g| |[:>|%!

Figure 11-30 The newly created second record









































































































































































































































































































































































































































































































































































































































































































































































































